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Important Notice 

This documentation is delivered subject to the following conditions and restrictions: 

The documentation contains proprietary information of Objet Geometries Ltd. Such 

information is hereby supplied solely for the purpose of assisting properly 

authorized users of the Eden330/333 system. 

Without the prior written permission of Objet Geometries Ltd, no part of the content 

hereof may be used for any other purposes, disclosed to any person or firms, or 

reproduced by any means.  

The text and drawing herein are for the purpose of illustration and reference only. 

The specifications on which they are based are subject to change without notice. 

Copyright © by Objet Geometries Ltd. All rights reserved . 

First Edition: April 2005 

Trademarks 

All rights reserved. Printed in Israel. No part of this book may be used or 

reproduced in any form or by any means, nor stored in a database or retrieval 

system, without prior permission in writing from Objet Geometries Ltd. 

Microsoft and XP are either registered trademarks of trademark of Microsoft 

cooperation in the United States and/or other countries. 

All the terms mentioned in this book that are known to be trademarks or service 

marks have been appropriately capitalized.  Use of a term in this book should not be 

regarded as affecting the validity of any trademark or service mark.  All other 

product names and services identified throughout this book are trademarks or 

registered trademarks of their respective companies. 

Eden330/333 User Manual Part Number: DOC 00019 Rev. C 



www.goengineer.com

3D PRINTER SALES
info@goengineer.com
800.688.3234

3D PRINTER SUPPORT
AMsupport@goengineer.com
855.470.0647

CONSUMABLES HELP
supplies@goengineer.com
855.470.0647

Objet Geometries Ltd Eden330/333 User Manual 

 1  - 2 

Using of the User Manual 

This User Manual offers information and complete instructions for operation and 

maintenance of Eden330/333 system. 

This manual assumes a basic knowledge of Windows XP® operating systems, 

including basic handling and proper working procedures. 

This user manual has been designed to provide instructions for the operation of the 

Eden330/333 System as well as to serve as a reference that the user can return to 

whenever more information is required about a particular topic.  Almost all the 

chapters of this book include hands-on examples to guide the user through real-

world situations.  In addition, the book provides detailed information for each of the 

features described with valuable guidelines, cautions and safety information. For 

inquires and application support contact Avi_Cohen@2Objet.com 

FCC Compliance Rules 

In accordance with FCC rules, section 15.105 for a Class A device: 

The Eden330/333 System has been tested and found to comply with the limits for a 

Class A device pursuant to part 15 of the FCC rules. These limits are designed to 

provide reasonable protection against harmful interference when the equipment is 

operated in a commercial environment. The Eden330/333 System generates, uses and 

can radiate radio frequency energy and, if no installed and used in accordance with 

the User Manual, may cause harmful interference to radio communication.  

Operation of the Eden330/333 System in the residential area is likely to cause 

harmful interference in which case the user will be required to correct the 

interference at his own expense. 
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1. General Safety Rules  
 

The safety cautions included in this chapter, and those to follow, are a mater of 

common sense. Please read all of the following chapters that apply to your 

particular work.  

All service operations should be performed only by qualified service personnel 

who have been instructed about any precautions that must be taken. 

 

1.1 In case the equipment is used in a manner not specified by Objet Geometries 

Ltd., the protection provided by the equipment may be impaired. 

 

1.2.1 Be familiar with the locations and use of safety equipment such as fire 

extinguishers, emergency showers, emergency exits, eyewash fountains, 

first aid kits, fire blankets, main electrical switches, and water hoses. 

1.2.2 Do not block the emergency equipment with boxes, trash, etc. 

1.2.3 Keep your work area clean. 

1.2.4 Use a dustpan to pick up broken glass; never use your hands. 

1.2.5 Packages containing equipment and parts should not be dropped, bumped, 

or crushed. They must be handled with care. 

1.2.6 The Eden330/333 System must be turned off and unplugged before it is 

serviced.  

1.2.7 Every accident, no matter how minor, must be reported to the safety 

officer. 

1.2.8 Do not use broken equipment. Inspect your equipment for holes or cracks 

before each use. 

1.2.9 Inform co-workers of plans to carry out non-routine, hazardous work. 

1.2.10 Please alert the safety officer, or any other appropriate authority, if you 

notice any unsafe conditions.  

1.2.11 Machinery with moving parts must have an interlock, and a protective 

cover over the moving parts. 

1.2.12 Do not open the hood while system working. Do not bypass the hood’s 

interlock. 

1.2.13 Do not stare at UV light. Use protecting eyeglasses while the UV light is   

on and main hood is open. 

1.2.14 In case of direct contact of resin with skin or eyes, wash thoroughly with 

water.   
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1.3 Storage of Resins  

 

The Eden330/333 System resins are composed of reactive monomers 

and oligomers. If improperly stored or handled, these compositions 

could undergo polymerization resulting in the evolution of heat. 

Improperly stored resins increase in viscosity, and eventually result in 

a gelled (polymerized) product in the storage container. Products 

should be stored in conformance with applicable fire department and 

insurance company regulations and other applicable laws, regulations, 

codes and guidelines. 

 

1.3.1    Storage: 

The Eden330/333 System resins are shipped in UV protective 

bottles. These bottles are acceptable as long as they are opaque 

to ultraviolet energy, and have not been contaminated with 

other chemicals prior to use in the Eden330/333 System. 

 

To ensure product stability, the resins should not be allowed to 

come in contact with any metal. Plastic containers made from 

monomer-soluble materials such as polystyrene or polyvinyl 

chloride (PVC) also should not be used for storage. 

         

 
 

Container lids must be tightly sealed in order to protect the 

product from contamination and/or stray UV energy when 

resins are not in use. Accidental spillage of resin can be 

minimized if the container lid is sealed tightly.  

Please note that the maximum quantity of flammable liquid 

stored in equipment is 18.90 liters (according to the UL1950 

standard). This amount is for liquids with flash point at or 

above 60°C (140°F) contained in closed containers made of 

glass, metal or plastic. 
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1.3.2   Shelf Life: 

The Eden330/333 resins have a shelf life of as indicated onto 

the bottle in undamaged, unopened containers, starting from 

the date of manufacture as printed on the container. Therefore, 

inventory provisions should be made to insure that the resin 

purchased first is used first. 

 

1.3.3    Light:  

Resins should be shielded from sunlight or other sources 

which produce UV actinic radiation such as fluorescent or 

mercury vapor lights. Exposure to UV energy leads to an 

increase in product viscosity and eventually to product 

solidification. 

 
 

1.3.4    Temperature: 

Containers of resin products should be kept indoors in a cool, 

dry area with adequate ventilation, and at temperatures 

preferably between 16°C (60°F) and 27°C (80°F).  

Always keep containers out of direct sunlight. 

 

                                 
1.3.5    Polymerization: 

Signs of premature polymerization in the container include 

bulging, leaking, the emission of heat, or an unusual odor 

emanating from the container. The precautions defined in the 

sections to follow should be taken if polymerization is 

suspected. 
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1.4 Transfer and Handling 

  

1.4.1    Flammability: 

Flammability is the ability of a material to burn. The degree of 

flammability hazard is often expressed as the flash point of a 

material or the temperature to which a material must be heated 

before a flame will ignite the vapors. Special precautions 

should be taken to prevent exposure of resins to heat, flames, 

sparks, or any source of ignition. If the containers are exposed 

to extreme heat, they may burst violently. 

 

1.4.2    Health Hazards: 

Any chemical may exert harmful effects if it enters the body in 

sufficient quantities. The hazard of a chemical is the likelihood 

that a chemical will produce damage under specified 

conditions, and is derived from two main considerations: 

 

1.4.3    Toxicity: 

Toxicity is the inherent ability of a chemical to produce a 

deleterious response in a biological system. All materials have 

some toxicity associated with them, which may be high or low. 

Toxicity can be measured in quantitative manners, which 

determine the nature of the toxic effect and the dose, which 

causes it. 

 

1.4.4.   Exposure: 

Care should be taken to minimize exposure to uncured resin. 

The risk of health hazard can be greatly minimized by 

minimizing exposure. 

 

1.4.5   Skin Irritation: 

Brief contact with high concentrations or prolonged exposure 

to low concentrations of uncured acrylate or epoxy-containing 

materials may cause tissue inflammation, itching, redness, dry 

patchy scaling, and/or discharge. Skin irritation is generally 

confined to the area of direct contact. Prolonged exposure may 

cause burns. Because direct skin contact may not always cause 

immediate irritation, skin exposure can easily go unnoticed. 
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1.4.6      Skin Sensitization: 

Sensitization dermatitis is the result of an allergic reaction to a 

given substance. In almost all cases, direct skin contact is 

necessary to cause sensitization. It is possible for individuals to 

become sensitized to a substance even after a trouble-free 

period of exposure.  

                              

Warning: Do not allow uncured resin to contact skin. Resin 

products may contain materials that are potential sanitizers. To 

avoid sensitization, do not allow uncured material to contact 

skin. Some epoxy resins are skin sanitizers, while others are 

not.  

1.4.7      Inhalation: 

Inhalation of resins has been regarded as less of a problem than 

skin or eye contact due to their low volatility, although 

volatility does vary by composition. Vapors may accumulate in 

areas without adequate ventilation, however, and some vapors 

do irritate the nose, throat and lungs. Therefore, all areas 

where resins are handled should be thoroughly ventilated. 

Ventilation capacity should be such as, to replace all air in the 

room 20 times in one hour. 

1.4.8     Ingestion: 

Resins may be toxic by ingestion. Therefore, these materials 

must not be present where food and drink are stored, prepared 

or consumed. 

   1.4.9     Handling of Cured Parts: 

The cured plastic parts can be handled and stored with no 

special precautions. Typical applications include concept 

modeling, prototyping, and tool pattern generation. 

1.4.10    Spill Control: 

Small spills, loosely defined as two gallons or less, can be 

cleaned up using disposable towels, non-reusable rags, or 

absorbing materials such as sawdust, clay, diatomaceous earth, 

activated charcoal, etc.  

All clean up materials should be placed in sealed, labeled 

containers. The spill area can then be cleaned with denatured 

or Isopropyl alcohol, followed by a thorough washing with 

soap and water. 
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1.5 First Aid 

 

This section includes first aid procedures in the event of exposure to the 

Resins. Always refer to the resin container label for information specific 

to the product being handled. 

1.5.1 Skin: 

In general, there is no reason for direct contact of uncured resin 

with skin.  

 

 

If resin or cured material comes in contact with the skin, 

immediately wash the contacted area thoroughly with soap 

and cool water, and then remove contaminated clothing. 

Particular attention should be paid to flushing the hair, ears, 

nose and other parts of the body that are not easily cleaned. 

The use of cool water is important to avoid opening the pores, 

which may allow more material to penetrate the skin. Do not 

use solvents to clean skin. If large areas of skin have been 

exposed, or if prolonged contact with resin results in blisters, a 

physician must be consulted. During first aid procedures, 

avoid the accidental transfer of resin from the hands to other 

areas of the body, especially to the eyes. Do not reapply barrier 

cream until the skin has been completely cleansed. 

Clothing should be professionally laundered. Do not launder 

contaminated clothing at home. Dispose of contaminated 

shoes, belts and other leather items because they can absorb 

resin and may re-expose the user at a later date. 
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1.5.2    Eyes: 

Attention of Customer Support Engineers only is required to 

wear safety glasses to prevent accidental splashes into the eyes. 

If contact with eyes occurs, flush immediately with large 

amounts of water for 15 minutes and avoid sunlight, 

fluorescent light, or other ultraviolet light. Eye wash facilities 

should be provided with a first aid kit situated close to the 

resin. 

 

           
 

 1.5.3    Contact Lenses: 

Attention of Customer Support Engineers only that wearing of 

contact lenses is not recommended. However, if contact lenses 

are worn, verify that flushing the eye with water removes the 

lens from the eye immediately. Get medical attention. 

 

If eye itching or burning occurs, remove contact lenses and do 

not refit new lenses to the eye until symptoms disappear. Also, 

clean and disinfect lenses with appropriate lens cleaner before 

refitting. 

1.5.4    Ingestion: 

If resin is swallowed, consult the container label for specific 

instructions. Get medical attention immediately. 

1.5.5    Inhalation: 

Vapors from resins as well as their combustion products can be 

very irritating to the respiratory system. Upon inhalation 

exposure to vapors or the products of combustion, 

immediately expose the affected individual to fresh air. If 

breathing has stopped, immediately begin artificial respiration 

or cardiopulmonary resuscitation.  

 

Get medical attention immediately. 

Oxygen should be administered by authorized personnel only. 

The patient should be kept warm but not hot. An unconscious 

person should never be given anything by mouth. 
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   1.6 Disposal Procedure 

 

Fully cured resins often present no special safety or health related 

disposal issues. Nonetheless, some areas may still regulate cured resins 

as hazardous industrial waste. 

 

The disposal of fully cured resins, should comply with all applicable 

local, state, and federal environmental and safety regulations. 

 

While removing the dirt container out from the Eden330/333 3D 

System it is essential to wear gloves. For direct contact with uncured 

formulation the Neoprene and Nitrile rubber gloves are recommended. 

For contact with cured materials (sometimes slightly uncured on the 

surface) common latex gloves are also acceptable.  

 

Partially or uncured resin waste may be classified as hazardous in some 

areas, thereby requiring special packaging, transportation and disposal. 

The disposal of partially cured or uncured resins, should comply with all 

applicable local, state, and federal environmental and safety regulations. 

The packaging, transportation and disposal methods used must prevent 

any form of human contact with the waste, even if it is classified as non-

hazardous or unregulated. This precludes the use of disposal methods 

that result in groundwater or surface water contamination. The disposal 

of cured, partially cured, or uncured resins, should comply with all 

applicable local, state, and federal environmental and safety regulations. 

 

Clean up materials, soiled clothing, empty containers, etc., should be 

disposed of in accordance with the preceding guidelines and applicable 

laws and regulations. Whenever any of these contain uncured or 

partially cured resin, the disposal method must preclude any form of 

human contact, including any method, which could result in ground 

water or surface water contamination. 

Discard contaminated shoes by isolating in a sealed container and 

disposing of as solid waste. 

Empty plastic bottles should be punctured, drained thoroughly, and 

disposed as solid waste. 
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1.2. Introduction 
The Eden330/333 prints three-dimensional models of designs made with most of the 

solid image design tools, such as Solid Works, Pro-E, Unigraphics and 

AutoCAD, in STL format.  

This User Manual has been designed to serve as an accompanying instructional text 

for use with the Eden330/333. It provides instructions for the operation of the 

Eden330/333 as well serving as a reference to which the user can turn whenever 

more information is required about a particular topic.  Almost all the chapters of this 

manual include hands-on examples to guide the user through real-world situations.  

In addition, it provides detailed information for each of the features described, with 

valuable guidelines, cautions and safety information.  

 

 

About This Manual 

The manual is divided into two main sections: 

1.Installation and operating instructions for the Objet Host software.  This 

section incorporates explanations of all the screens and dialogs, up to the 

point where the BUILD command is actually sent. 

2.Operation and maintenance of the Eden330/333 Printer. The System is 

operated via an Embedded program. 
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Concepts Used in This Manual 

 

Model Material Material used for building the model. 

Support Material Material used for support in model building. 

STL  Type of input file to be used with the Objet 

software. 

OTF (Objet Tray Format) File comprising all information needed for a 

single job of model building. 

EDEN330/333 Your Objet Eden330/333 System. 

Host Workstation The workstation on which the Objet Host 

software is installed. 

Objet Studio The Software Application which enables the 

user to prepare a printing job for printing 

(building) 

Job Manager The Software Application which enables 

management of the printing job. 

Embedded Program Real-time Software within the printing device 

that controls all operations of Eden330/333. 

Embedded Screen Graphic user interface of Embedded program. 

Build Tray The building surface upon which model/s are 

placed and defined for building. 
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2.3. Getting Started 

Minimum Requirements for the Host Workstation 

• Processor: Single Processor Pentium 4 speed 2.4GHz and up; 512KB Cache. 

• Operating System: Microsoft Windows XP. 

• Graphics Card: ATI RADEON 9600 Supporting Open GL with 128MB and up. 

• Memory: 1 GB RAM and up. 

• Floppy Drive: 3.5” 1.44MB Floppy Drive. 

• CD ROM Drive: IDE CD ROM Drive. 

• Hard Drive: 40GB & up. 

• Network Card: Two network cards with cross cable LAN TCP/IP installed on one 

of them. 

 

           How to Install Objet Studio in the Host Workstation 

1.Insert the Objet Studio CD into the appropriate drive. 

2.Right click the Start button and select Windows Explorer. 

3.Scroll up to the CD drive and select Setup. 

4.Follow the installations instructions. The software will prepare an Icon 

on your desktop named Objet Studio for easy access. 

About Objet Studio Software 

Objet Studio is a Windows-based application with a familiar Windows interface.  

The operating instructions include a variety of options and tasks, and involve the 

following steps: 

1.Inserting one or more objects on the Build Tray. 

2.Positioning the object(s) on the tray. 

3.Setting the object/tray parameters.  

4.Saving the above information as an OTF file (Objet Tray Format). 

5.Sending the tray to Build. 
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2.13.1.1 Preparation of External File from CAD 

Workstation 

  

The following is a list of the steps that should be taken in order to prepare the 

external file for use by the Eden330/333, and subsequently to prepare the selected 

model for printing.  There are slight variations between the different solid image 

design programs in which external files are prepared. These instructions, however, 

apply to all programs. 

To prepare an external file for use by the Eden330/333 system: 

1.On the main menu bar select File>Save As.  The Save As dialog box 

opens.  

2.In the Files of Type window select the extension (*.STL) 

3.Select Options and choose from the following: 

 

 

Total Quality – default value of approximately 0.01.   

Detail Quality – default value of approximately 14º.  

The lower the value selected, the more accurate the saved file, although the 

saved file is correspondingly larger. 

Resulting triangles should not be smaller than Z resolution of 0.02mm. 

1.Select an option and press OK. 

2.Click Save. A picture of the file model, showing its structure built in 

triangles, appears along with a window that provides information on: 

� Number of Triangles 

� File Size 

� File Format: Binary (preferable) or ASCII 

� Save – the address where the file will be saved 

� Yes/No 

 

3.  To save the file in STL format, select Yes. 

 

 

 

 



www.goengineer.com

3D PRINTER SALES
info@goengineer.com
800.688.3234

3D PRINTER SUPPORT
AMsupport@goengineer.com
855.470.0647

CONSUMABLES HELP
supplies@goengineer.com
855.470.0647

Objet Geometries Ltd                                      Eden330/333 User Manual 

                                                                                                                        3  - 13 

2.23.1.2 What is an STL File? 

 The STL or stereolithography format is an ASCII or binary file used in 

manufacturing. It is a list of the triangular surfaces that describe a 

computer generated solid model. This is the standard input for most rapid 

prototyping machines. 

The ASCII.STL file must start with the lower case keyword ‘solid’ and end 

with ‘endsolid’. Between these keywords are listings of individual 

triangles that define the faces of the solid model. Each individual triangle 

description defines a single normal vector directed away from the solid’s 

surface followed by the X-Y-Z components for all three of the vertices. 

These values are in Cartesian coordinates and are floating point values. 

The triangle values should all be positive and contained within the 

building volume. For this project the values are 0 to 14 inches in the X, 0 to 

10 in the Y and 0 to 12 in the Z. This is the maximum volume that can be 

built but the models should be scaled or rotated to optimize construction 

time, strength and scrap removal. The normal vector is a unit vector of one 

length based at the origin. If the normals are not included then most 

software will generate them using the right-hand rule. If the normal 

information is not included then the three values should be set to 0.0.  

The following diagrams illustrate the STL format: 

  

 

                     

 

Figure 1: STL format triangles Figure 2: STL format triangles  
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3.4.  About Objet Studio  
  

3.14.1.1 Selecting a Model File (Object) 

Double click on your desktop shortcut to Objet Studio. The opening screen appears 

displaying an empty build tray. 

       

 

                                                              Figure 3: Opening screen 

  

To select a model file for positioning on the tray, do one of the following: 

V       Place the cursor on the tray and click on the right mouse button 

V       From the Main Menu Bar select Object>Insert 

V       Press the Insert Model icon button. 
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  The Insert dialog box appears 

 

 

                                            Figure 4: Insert Dialog box 

  

To select the file Use the browser to navigate to the library in which the file 

for printing has been saved. Choose file or files by clicking 

on them with mouse (multiple selection is allowed using 

SHIFT and Ctrl keys, as usual). 

To preview the 

file 

Click in the Preview check box at the bottom right of the 

screen.  The Model appears in the Preview window. 
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Units Open the drop down list next to Units and select the 

appropriate units of measurement for the model 

(millimeters or inches).  Determine the unit type by 

examining the values in the Extents fields.  Values of less 

than or circa 10 may mean that the measurement unit is 

inches.  Larger values may mean that the unit is millimeters. 

The size of the Build tray is 330/333 mm(x) 330/333 mm(y) 

200mm(z) 

To Insert To insert selected objects, press Open. Models appear on the 

tray. 

Number of copies Insert the number of copies from the selected model to be 

placed onto the tray. 

Quick Automatic 

Placement 

If Quick Automatic Placement is active, all models would be 

automatically positioned on tray. 

 

 

3.24.1.2 Placing More Than One Model on the Tray 

  

To place more objects on the tray, revert to Object>Insert.  Select an additional 

file/files and proceed as detailed above. 

To place more than one copy of the model / duplicate a model on the tray:  

• Click on the current model to select it 

• Click on the right mouse button and select Copy to place the model 

in the clipboard. 

• Click on Paste to copy a single model on to the tray, or 

• Click again on the right mouse button and select Paste Special   The 

Paste Special dialog box appears. 
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4.1.3 Paste Special 

 

 

                                                   Figure 5: Paste Special dialog box  

  

The Paste Special dialog box contains the information required to insert 

additional copies of the object. Enter information as detailed below: 

Number of copies: Type in a number, or use the arrows provided.  

Delta:  Distance between copies along X, Y and Z axes. 

Mirror:  Allows the option of placing a copy of the model as a mirror image 

on the tray.  

For example: the settings from Figure 5 result in a Tray placement as shown 

below: 
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                                Figure 6: Build Tray after Paste Special 

 

3.34.1.4 Selecting an Object(s) on the Tray  

Selecting an Object(s) on the Tray  

To perform a task involving the positioning or moving of an object on the tray, you 

need first to select the object.  

To select an object, place the cursor on the object and right click with the mouse 

button. 

Note: The object changes color when selected.  

To select more than one object from the tray: 

V Place the cursor on the first selected object and right click with 

your mouse. 

V Place the cursor on the next object to be selected and holding the 

Shift or Ctrl key, right click the mouse.  Both selected objects now 

change color. 

V Repeat step 2 for all the objects to be selected. 
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3.44.1.5 Considerations for Placing/Positioning a 

Model   
  

Although the decision as to where and how to orient, place and position a model on 

the tray needs to take into account a variety of factors, there are actually no hard and 

fast rules.  Each case should be considered individually.  The guidelines provided 

below are helpful when making the decision. 

4.1.6  The X-Y-Z Rule 

A primary consideration when positioning a model is its outer dimensions. The 

Eden330/333 prints (scans) along the X-axis and so printing time along this axis 

relative to total printing time does not take long.  This being the case, it is 

recommended to place the object’s longest dimension along the X-axis 

The ink-jet head width is 65mm. This means that any model with a width of less than 

65mm is printed in one scan. This being the case, it is recommended to place the 

Intermediate dimension along the Y-axis. 

The high resolution printing (1270 DPI) on the Z-axis and the fact that each printing 

layer is equal to 20 microns mean that it is time-consuming to print a tall object. This 

being the case, it is recommended to place the smallest dimension along the Z-axis. 

In summary, always try to position an object on the tray with: 

•       The longest dimension along the X-axis 

•       The intermediate dimension along the Y-axis 

•       The smallest dimension along the Z-axis 

  

4.1.7 The Hollow-up Rule 

When printing models with drills, holes, hollow or unfilled surfaces it is important 

to locate them face up so that unfilled surfaces are not filled with Support material. 

4.1.8  The Fine Surface Rule 

When printing models with fine details on the outer surface (e.g. the keypad side of 

a phone set) we recommend positioning the side with the fine detail face up. This 
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means that the upper (detailed) surface is printed without Support material, giving a 

fine-smooth finish. 

4.1.9  Z-From Left To Right Rule 

 

The Eden330/333 prints (scans) along the X-axis, moving from the axis origin to the 

right.  It is therefore efficient for a model that is partly high and partly low to 

position the highest part of the model close to the X-axis origin, so that the heads do 

not have to move all along the tray to print the slices of the taller part, once printing 

of the lower parts has been completed.   

4.1.10   Avoid Support Rule 

 

For an object like a pipe or tube, it may be better to print it standing up (no support 

material inside the pipe) rather than in the lying down position even though the 

latter method is faster. This is so that the hollow inside of the tube or pipe is not 

filled with support material (as in 3.5.2 above). 
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3.54.1.11  Tray Architecture   

The architecture of the tray is laid out on the left hand side of the tray 

screen, in a manner similar to that of MS Explorer. 

• Double click on Geometry and the objects appear one below the other 

listed as Placed Elements. 

• Click on an object (Placed Element) and the image on the screen 

changes color indicating that it has been selected. 

• Click on more than one Placed Element in the list while holding the 

Shift key, and the object images on the screen change color 

simultaneously as they do when clicking directly on the object 

images 

• Right click on an object (Placed Element) and the Popup menu 

appears. 

  

3.54.1.12   The Objet Studio Toolbars 

    

 

                                    Figure 7: The Objet Studio Toolbars 

  

Figure 7 shows all the Objet Studio Toolbars. It is not necessary to display them all 

on the screen at the same time. 

 

To access the toolbars from the main menu bar: 

•   Select View>Toolbars to display the checklist in Figure 8. 

•    Click the checkbox to select the required toolbar. 

        Press OK to confirm the selection.                           
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                                             Figure 8: Toolbar selection checklist 

 

Some of the buttons that appear on the Objet Studio toolbars are familiar from 

standard Windows programs and do not require explanation.  The remaining 

buttons are designed to provide maximum flexibility in viewing and positioning 

models on the build tray. Place the cursor on an Icon and the Icon name appears. 
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3.54.1.13  Inserting and Moving a Model 

 

The following Icon buttons facilitate the tasks involved in inserting an object onto the 

build tray and moving the object and/or the tray around in the View Window. 

                            Table  1:  Inserting and moving icon buttons 

ICONS TASK 

 
Select 

Translate 

 

Rotate 

Scale 

• To select a model, click on the Select button, then on 

the model. The color of the selected model changes to 

light blue. A model can be manipulated only after it 

has been selected. 

• Click the Translate button to move the model around 

in the view screen. 

• Click the Rotate button to turn the model around on 

either of the X Y Z axes. 

• Select the Scale button to change the size of the model. 

Click and hold the left mouse button and move the 

cursor over the object, to decrease or increase the size 

of the model. 

 
Lay on 

• The Lay on button positions the model so that it is 

sitting on the build tray.  This action insures that the 

model is not floating above or beneath the surface of 

the tray. 

 
Group and 

Ungroup 

• The Group and Ungroup buttons are operative only 

when more than one model has been selected.  

Grouping two or more models enables their 

manipulation as a group, as opposed to individually. 

 
On/Off Grid 

Snap to Grid 

 

 

• Moving from left to right: 

• Select the On/Off Grid button to toggle the grid in the 

view screen. 

• The Snap to Grid button causes any movement of the 

selected model to result in its being positioned 

according to the grid.  The model snaps to grid on 

completion of any movement. 

• Select the Grid Origin button to move the Grid Origin 

Point to the desired position in the viewing screen. 
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ICONS TASK 

Grid Origin 

Reset Grid 

• Select the Reset Grid Origin button to restore the Grid 

Origin Point to the default position. 

 

Wire Frame 

Shaded 

• The Wire Frame and Shaded buttons enable toggling 

between an outline view of the model and a solid object 

view. 

  

 

3.74.1.14   Positioning the Model(s) 

 

                                          Table  2: Positioning icon buttons 

 

ICONS TASK 

 
Dynamic Checking 

 

Tray Validation 

 

 

 

 

 

Automatic Placement 

 

From left to right: 

• Select the Dynamic Checking button to prevent 

invalid placement of the model.  Click again to 

cancel. 

• Select the Tray Validation button to validate the 

Tray.  If the placement of the models or Models 

themselves are invalid for any reason, problematic 

models will appear colored, as defined in the 

constraints settings 

• Select the Automatic Placement button for 

automatic and valid placement on the tray by the 

software.   

• Selecting this Icon button is equivalent to clicking 

the checkbox in the Section dialog box in order to 

view the section. 
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Enable Clipping 

 
Select Plane  

Align Bottom/ Top 

Align Left/Right 

Align Front/Back 

 

 

••••    Choose the Select Plane option to mark a surface 

onto the model located on the tray. One may 

attach this surface to the tray (align bottom) or 

place the opposite surface of the selected plane 

(align top) or orient in other directions 

accordingly.. 

 

  

3.74.1.15  Viewing and Movement Options 

 

                                       Table  3: Viewing & Movement Icon buttons 

ICONS TASK 

 
Camera View 

 Select the Camera View button to view the object on the 

build tray from the viewpoint of a virtual camera lens. The 

position of the camera may also be established and 

subsequently pointed to view the model. 

 
Windows View 

 The Windows View buttons enable selection of up to four 

simultaneous windows, each showing the object(s) in 

different projections. 

 
Zoom In 

Zoom Out 

 Select the Zoom In and Zoom Out buttons to view the 

model and build tray from a closer or more distant 

perspective. 

 
Pan Buttons 

• Use this set of Pan buttons to facilitate moving the build 

tray and contents from side to side or up and down for 

easy positioning in the view window. 
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ICONS TASK 

 
Backward & 

Forward 

• The Advance Forward and Backward buttons facilitate 

movement of the build tray and its contents so that the tray 

appears to move towards or away from the viewer. 

 
Millimeter or 

Inch Units 

• Select the Millimeter icon for converting an inch-inserted 

model into millimeter units.  Select the Inch icon for 

converting an millimeter-inserted model into inch units 

 

 Rotate 

• Use this set of Rotate buttons to rotate the selected model 

in the direction indicated by the arrow. 

 
Zoom  

• These icons permit zooming in on the object or tray. 

 
Perspective 

Parallel 

• Use the Perspective/Parallel button to create a slight 

change in perspective for viewing the build tray and its 

contents.  

 
Zoom by 

Rectangle 

Zoom by Line 

• The Zoom by Rectangle and Zoom by Line buttons 

provide additional options for zooming in on the selected 

object on the build tray. 
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ICONS TASK 

 
 

Zoom Dynamic 

 

 

Pan Dynamic 

 

 

 

Walk Dynamic 

 

 

Study Dynamic 

• Select a button, then holding the left mouse button down, 

use the mouse to move the build tray with its contents.  The 

following is a description of the options from left to right: 

• The Zoom Dynamic button enables continuous zooming 

in on the model without the step-like progression of the 

Zoom button. 

• The Pan Dynamic button enables continuous movement 

of the model and build tray without the step-like 

progression of the Pan buttons. The movement occurs 

according to the direction of movement of the pointer. 

• The Walk Dynamic button works in a similar fashion to 

the Pan Dynamic button, except that the movement is in the 

opposite direction to the movement of the pointer. 

• The Study Dynamic button enables rotation of the entire 

study (build tray and model together).  If used in 

conjunction with the Spin Mode button (see below), the 

study will rotate continuously in the view screen. 

 
Sticky Mode 

Spin Mode 

From left to right: 

• Select the Sticky Mode button to maintain a selected button 

in a continuously selected state. 

• Select the Spin Mode button to cause the build tray and its 

contents to spin continuously.  When used in conjunction 

with one of the rotate options, the build tray will spin in 

the way that has been selected by the rotate option. 

 
Build 

• Select the Build button once all objects are properly 

placed. This is the final command prior to saving the tray 

information as an OTF. 

 
Estimate 

Consumption 

• Select the Estimate Consumption button for calculating 

the printing time per tray, and the material consumption 

per tray/model.  

This icon is equal to ‘Tools’, ‘Estimate Consumption’ from the 

main pull-down-menu. 
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3.84.1.16  Main Menu-Bar Options 

  

Most of the options accessed via the Icon buttons listed above can also be accessed 

from the main menu at the top of the screen.  

To open a main menu bar option, click on it and a drop-down menu appears.  Many 

of the options are standard Windows commands 

Following is a list of Main Menu commands. 

 

3.84.1.17  File Menu 

 

From the Main Menu Bar select File> 

 

New To open a new empty tray. 

Open To open a saved file, OTF (or STL for viewing mode only). 

Close To close an open file (Standard Windows command). 

Save To save a file  (Standard Windows command). 

Save As To save a file as an OTF with a file name in a designated 

library. 

Build The final command prior to slicing (see Build Icon on this 

page). Following this command, if an OTF has not yet been 

created, the Save As OTF dialog appears. 

  

 

 

File>Page Setup To set page parameters for printing a picture of the 

model.  The Page Setup dialog box appears; it is similar 

to the standard Windows Page Setup. 
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                                               Figure 9: Page setup dialog box 

  

Type in the required page setup parameters then click the System button. 

 

Note: The following commands do not refer to your Objet Eden330/333 but to a 

regular printer! 

 

• File>Print   Preview provides you with a preview (Standard Windows   

                  Command). 

• File>Print   Sends the picture to the regular printer. 
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3.44.1.18  Edit Menu 

From the Main Menu Bar select Edit> 

Undo/Redo  To undo/redo last operation. 

  

Cut, Copy, Paste Standard Windows commands. 

  

Paste Special See page 8. 

Delete To delete an object from the tray. 

Edit>Properties The Properties dialog box opens with five tabs. 

     General Tab 

You can insert a description 

in the Description field.  

  

 

      Transform Tab 

Uniform Scaling: Click in 

the Checkbox for Uniform 

scaling in all 3 axes. 

Rotate: round any axis X,Y, 

or Z. The Rotate value is 

relative to the starting 

position. This means that if 

a correction is made you 

type in the actual new value 

and not the increment. 

Scale: Relative to the 3 axes 

Dimensions: The actual 

dimensions of the model. 
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Statistics Tab 

Displays File name and 

location together with 

general statistics. 

 

Build Tab 

Displays the select build 

option. ‘Matte’ for building 

with support layer around 

the part, ‘Sateen Surface’ for 

automatic selection of 

support enclosure and ‘Full 

Glossy’ for no support 

around parts (this option is 

restricted for special 

geometries as shown 

hereafter). 

 

  

  

Info Tab 

This tab contains size 

information concerning the 

bounding box.  

Note: The Model and 

Support Consumption 

would be presenting the 

estimated consumption 

after the user would request 

this calculation, from: 

‘Tools’ – ‘Estimate 

Consumption’ menu. 
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3.44.1.19  Selection of Build Parameters 

 

  

Note: The Build parameter defaults have been carefully selected and the values on 

the Objet Studio screen are suitable for most model building (printing).  Please 

call Objet Customer Support if you wish to alter the defaults. 

        

                          

                                        Figure 10: Surface Selection Screen  

 

3.84.1.20  Build on Pedestal 

Pedestal: The pedestal structure is selected automatically 

based on material selection. 

A “Pedestal” is a build of a complex support 

structure of predefined height in order for a model to 

be built upon it. This option allows the user to attain 

easy removal of the printed part from the tray. 

This option is selected by the Objet Studio for 

Eden330/333 users. 
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3.84.1.21 Build Types 

Matte Surface Builds a complete support structure shell around 

the entire model.  

 

  

Full Glossy  Builds no support shell around the model. This 

option is for experienced users only, because it is 

geometry dependent and is not acceptable for 

every model printed. 

 

                                

  

                                         
  

                                                     Figure 11: Matte Surface 
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3.84.1.22  View Menu 

 

        From the Main Menu Bar select View> 

 

Points Displays the model with the triangle coordinates (points) only. 

Wire Frame 

Shaded 

Displays an outline view of the object. 

Displays a solid object view.  

 

Display 

Bounding 

Box 

Displays the Bounding Box instead of Model geometry. 

Toolbars Opens the ”Customize” dialog. 

Status bar Displays the status bar at the bottom of the screen. 

Layout Opens a checklist from which 1,2,3 or 4 views may be selected. (See 

Windows View buttons in the Icon table on page 15.) 

 

                            Figure 12: Views From Layout 
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3.84.1.23  Object Menu 

 

 

            From the Main Menu Bar select Object> 

Insert Opens the Insert dialog box (see page 7). 

Translate 

Rotate 

Scale 

These options enable the user to manipulate the object(s) on 

the tray. The tasks they perform are equivalent to those 

performed by the Icon buttons described on page 12. 

Click on an object to select it. The color changes to light blue. 

Click on the selected option and move the cursor over the 

selected object.  

Move the cursor with the mouse button pressed. The 

equivalent Icon appears over the object and the task is 

performed as detailed on page 11. 

 

Lay on 

 

To position the object so that it is placed directly on the 

build tray – to ensure that it is not floating above or beneath 

the surface of the tray. (See Lay on button page 13.) 

 

Flip 

 

Opens a dropdown list showing the three axes X, Y, Z. 

Choose an axis and click on a selected object. The object flips 

over on the axis you selected. 

 

Fill Color 

 

Click to open Windows color pallet. This allows the selection 

of a color for the object(s) on the screen. 

 

Group 

Ungroup 

 

These options are operative only when more than one model 

has been selected.  Grouping two or more models enables 

their manipulation as a group.   
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Split 

Option 

 

The Split option, located at the ‘Objet’ pull-down-menu 

enables the user to perform simple cut to parts for tray 

fitting. 

Using the Split options, one may cut the part at a fixed 

distance (default maximum tray envelope). Note that all cut 

parts would be saved in a new directory carrying the STL 

file name. 

           

 

    

 
                                                     Figure 13: Split Screen 
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3.84.1.24  Tools Menu 

 

      From the Main Menu Bar select Tools> 

 

 Grid Displays the Grid on the screen. 

 

Snap to 

Grid 

  

The selected object is positioned in line with the Grid.  

After any movement of the object, it will automatically  

line up with the Grid (Snap to Grid) 

See Icon table on page 13. 

 

 

Constraints 

settings 

  

  

  

  

  

  

  

The Placement Validation opens showing a color 

code for the constraints parameters: 

V         Outside Tray 

V         Collision 

V         STL Problems 

To select Dynamic Check, click the Dynamic check  

box. A check (validation) may be specifically  

performed to see if the object is outside the tray, or colliding 

with another object on the tray.  

This may be done by clicking a checkmark in the  

relevant box.   
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Figure 14: Constraints Settings   dialog 

 

Click on any of the colored boxes to open the 

color pallet. The color that appears may be changed  

in order to alert the user of the problems with objects  

on the Tray. 

 

Tray 

validation 

Validates objects on the tray for printing (Building)  

in line with the constraints settings (see above).  For example, if 

the object is outside the tray it will appear  

in red.  

 

Automatic 

Placement 

Automatically places the objects on the tray in  

the optimal position. 
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Section Displays a cross section of the objects on the tray.  

This allows examination of the internal structure 

of the object to plan the necessary support. 

Click in the checkbox to activate (enable clipping). 

The sliding bars enable the user to select the best 

 position for the section. 

  

            

                         Figure 15: Section  

Options 

The Options 

dialog opens 

with five 

tabs. 

Grid  

The Grid tab 

enables you 

to adjust the 

Grid 

parameters 

as displayed. 

 

 

 

 

 

               

                               Figure 16: Grid settings 
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Manipulate  

Set defaults 

for working 

with 

Transform 

Toolbar. 

             

                             Figure 17: Manipulate settings 

 

 
Display 

The Options 

dialog 

enables to 

set the 

default 

display. 

  

               

                             Figure 18: Display 
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Settings 

The Options 

dialog 

enables to 

set the 

default 

values for 

the 

‘Automatic 

Placement’ 

(Select: 

Placement; 

Orientation; 

automatic 

placement). 

                             

                                 Figure 19: Settings 

  

 

 

Advanced 

The Options 

dialog 

enables to 

set 

improved 

values for 

Open GL 

video card. 

For further 

information 

regarding 

this option, 

please 

contact 

Objet 

Technical 

Support. 

                             

             Figure 20: Advanced  

 



www.goengineer.com

3D PRINTER SALES
info@goengineer.com
800.688.3234

3D PRINTER SUPPORT
AMsupport@goengineer.com
855.470.0647

CONSUMABLES HELP
supplies@goengineer.com
855.470.0647

Objet Geometries Ltd                                      Eden330/333 User Manual 

                                                                                                                        3  - 42 

3.134.1.25  Saving Tray and commencement of Build 

  

Now all the models are properly placed and ready for Building. 

From the main menu select File>Build Tray. 

 

                                            

                                           Figure 21: Selecting the Build command 

 

 

Note that when selecting the Build option, the current tray will be saved 

(overwritten) automatically. If the tray is a new tray, i.e., has not yet been 

saved under an .OTF file name, the user will be prompted to save the 

current tray via the Save As dialog box, as shown in the figure below. 
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                                                  Figure 22: Save As OTF dialog box 

 

 

             Select a location for the file in the Save in field. 

 
V               Type in a file name. 

V               Make sure that Save As type shows Objet Tray Files (*otf). 

V               Press Save. 

  

Once the Build command has been selected (and the job saved), Objet Studio 

sends the job to the Job Manager, and the Objet Studio application closes itself.  
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3.134.1.26  Working With Resin Replacement   

 

An enhanced features of the Objet Studio is a recognize tool for current loaded resin 

type. Each resin type (i.e. FullCure 720, Vero, or Tango) has its own unique 

characteristics and therefore special printing modes.  

Once launching the Objet Studio, a clear message will advise what resin type is 

currently loaded (refer to the figure below: ‘Currently Loaded: FullCure720). This 

on-screen display, enables the user to immediately be advised as per loaded resin in 

the Eden system. 

                               
Figure 23: Working with resin replacement 
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In addition to the displayed current resin type, the user should select the material 

type, once a tray preparation is required. Thus, while preparing a tray for 

TangoBlack resin, the user should select from the main toolbar the selected tray, and 

then insert the STL parts and prepare the tray. 

Please note that although the system is loaded with one type of resin, the user can 

prepare trays for different types of resin, and save its corresponding OTF file. Then 

after loading the required resin with Resin Replacement Wizard in the Eden 

Software, he may open the saved trays and print them. 

Note that the tray size may be shown different for some selected resin types, due to 

each resin’s unique characteristics. Hence, a Tango resin may show and require a 

smaller tray size as shown in figure 24 below. 

The Objet Studio application will generate an alert message while trying to printing 

a tray (for certain resin type) different than loaded in the machine. 

                           
Figure 24: Preparing the TangoBlack Tray 
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5. About Job Manager 
When Job Manager receives a new job the Job Manager Screen appears and begins 

pre-processing automatically. The Embedded screen will show the ‘Run’ icon as 

active  

 

                                          Figure 25: Job Manager Screen 

 

• Select the ‘Job Info’ icon (or select from the pull-down menu) to review the    

                  Tray Properties, such as build parameters, material consumption and   

                   estimated printed time, per model or per tray.                                       

             

                                                      Figure 26: Properties Screen 
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•    The View menu includes the ‘ToolBar’ option (active if checked), the 

‘Status Bar’ option (to present messages on Job Manager status line), the 

‘Refresh Status’ (to update the on screen values), the ‘Show Outgoing 

Slices’ (to show each slice being sent for building), and the ‘Show 3D 

Progress’ (to show actual building in 3D view). 

  

                                              

                                                           Figure 27: View Screen 

 

 

• The Job menu includes all features also in the icons line. ‘Restart Job’ for 

printing from a certain slice, Pause, Stop, Resume, Delete Job, Preview 

Slices, Review Job, and Job Info. 

 

                                 

                                                   Figure 28: Jobs Screen 
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4.45.1.1 Report Options 

Select the ‘3D Printer/Preferences… ’ from the Job Manager main menu to set your 

desired report options. 

          

  

 

                                    Figure 29: Preferences Dialog 

 
• Sound Alert – The application will generate a sound alert for any message 

appears on the Job Manager screen. 

• Report to System – Select this option to print a hardcopy of successful job 

results. 

•  Report to Email – Job Manager will send email messages regarding any event 

as chosen for each recipient in the list. This option requires E-mail messaging 

software that supports Windows MAPI to be installed on your Host 

Workstation (Outlook, Netscape Messenger etc.). 
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5.1.1.1 Report Via SMS: 

 

 Job Manager will send brief messages regarding any event as chosen for 

each recipient in the list. This option requires E-mail messaging software, 

which supports Windows MAPI to be installed on your Host Workstation 

and some mechanism for retransmission of messages to cell-phones.  

 

Note: The ‘Report Via SMS’ feature can be activated with Microsoft           

Outlook 2000 (which support Windows MAPI) and does not operates 

with Microsoft Outlook Express   

Configuration settings for SMS Report:  In order to configure the SMS 

report, select the ’Report via SMS’ checkbox.  Then by clicking on the ‘Add 

Receipt’ icon – the Microsoft Outlook2000 will pop-up. Add the selected 

email address of you mobile phone messaging system for retransmission of 

messages to cell-phones.  

Please note that in order to get SMS messages to you cellular phone, your 

mobile phone company MUST support the transmission of email to SMS. 

The Job Manager will deliver therefore only the ‘Subject Line’ with no 

attachments. 
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                                          Figure 30: Setting the SMS Report 

 

4.55.1.2 Configuration Options 

For use by Technical Support personnel only. 

 

4.65.1.3 Building  

Having set all the necessary parameters you are now ready to send the Build 

command. To do so: 

• Press the Build Tray button on the toolbar of the Main Objet Studio screen. 

Application sends a job to Job Manager and closes. 

• Make sure that you have completed the Start Procedure for the Eden330/333 

Printer. 

• Press Run on the Embedded computer. 

  

  

4.75.1.4 How to Resume a Printing process 

The Printing process may be interrupted for a number of reasons.  

For example, if interruption was initiated by machine (power off, technical problem 

etc.), Job Manager will stop sending slices and generate the following message: 

 

 

                                        

                                         Figure 31: On Screen Message 
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In order to continue/resume printing from the same slice, follow these steps: 

 

• Verify that the machine and Embedded computer are both ON. 

• Ensure that the network between the Embedded and Host is active. 

• Home all machine axes (including Z axis) and perform a pattern test 

(you may run the printing wizard which includes and required 

activities, such as, purges, wipes etc.). 

• Now, when the machine is ready for printing, select the ‘Resume’ 

icon on the Job Manager screen. 

 

• The application will prompt the user to enter the ‘Continue from Slice’ 

number, showing proposed next slice. 

• At this point the user has to select the appropriate slice number. This can 

be done by observing the last slice printed (in the Embedded screen). 

• If the wrong slice number was selected, the Embedded application will 

generate a warning message, advising the proper (last) slice number. 

  

 

 

                                                     Figure 32: Resume Option 
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6. Operation and Maintenance  
  

V      Read all of the following chapters that apply to your particular work. 

V      Do not open the hood while the system is working. Do not bypass the 

hood’s interlock. 

V      Do not stare at the UV light.  Use protective eye glasses while the UV is ON. 

V      Do not touch the Model and/or Support material with bare hands. Wear 

gloves during cleaning of the Model and/or Support material from the 

machine.  If you make skin contact with Model and/or Support material, 

wash the area as soon as possible with water and mild detergent. 

1.1      Installation and Training Rules 

  

An authorized Customer Support representative from Objet Geometries Ltd. 

will perform the following tasks: 

V      Unpack, install, assemble and completely check the Eden330/333 system 

before approving it for operation. 

V      Train the selected personnel to operate the system.  Only trained personnel 

are qualified to operate the system. 

V      Only an authorized Customer Support representative from Objet will be 

responsible for the system service and maintenance. 

V      The user must follow all safety rules and regulations as described above. 

  

  

  

6.1.1   Working with the Eden330/333 System 

          Procedure for Starting on the Eden330/333  

1.   Check that there is sufficient material in the cartridges (see Loading      

       and  Replacing Material Cartridges). 

2.   Check that there is no printed model on the tray. 

3.   Perform the Daily Maintenance procedure. 

4.   Start the EDEN330.EXE program at the Embedded Workstation. 
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                        Figure 1: Application Main Screen  

  

 

  

6.1.2 Procedure for Shutting Down the Machine 

1.      Click the Option pull-down-menu, and select the Shut Down option. 

2.      Press [Next] when ready, or [Cancel] to abort operation. 

3.      The system will empty existing material in printing heads, and   

perform wiping. Please note that this sequence will take about 5 

minutes. 

4.      Turn off the EDEN330/333.EXE program. 

5.      Switch off the machine. 

 

 

 



www.goengineer.com

3D PRINTER SALES
info@goengineer.com
800.688.3234

3D PRINTER SUPPORT
AMsupport@goengineer.com
855.470.0647

CONSUMABLES HELP
supplies@goengineer.com
855.470.0647

Objet Geometries Ltd                                      Eden330/333 User Manual 

                                                                                                                        3  - 3 

 
 

                                 Figure 2: The Shutdown Wizard 

 

6.1.3 Procedure for Performing Pattern Test 

As a periodic procedure, it may be necessary to perform a pattern test, and 

to examine the nozzles status. In order to perform a pattern test, follow the 

next steps. 

Enter the main menu, and select the Pattern Test option from user ‘Options’ 

pull-down-menu. 

Pattern test would be printed onto working table, as shown in the figure 

below. 

Confirm the Pattern Test message, and place a paper for the printed 

pattern test. 
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                                         Figure 3: Pattern Test Screen  

 

  

                                          
                                        Figure 4: Pattern Test Mapping 
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6.1.4 Preparing the Machine for a Prolonged Pause  

It is sometimes necessary to leave the machine for several hours or 

possibly days (weekend). The following describes the procedure to be 

followed when preparing the machine for such a prolonged pause.  This is 

not closing down the machine as detailed above. 

1.      Ensure that the Objet Studio program in the Host computer is idle 

(not in printing mode). 

2.      Click the Options pull-down-menu, and select the Shut Down option. 

3.      The system will empty existing material in printing heads, reduce 

heads heating, and perform wiping. Please note that this sequence will 

take about 5 minutes. 

5.      Do NOT turn off the machine or the EDEN  software. 

  

  

6.1.5 Procedure for Restarting the Machine after a Pause 

1.     Check that there is sufficient material in the cartridges (see Loading 

and Replacing Material Cartridges). 

2.     Click the Options pull-down-menu, and select the Pattern Test option. 

3.      The system will prompt the user to continue with this sequence, or 

abort the selected option. Press [OK] to continue. 

4.    Once the Pattern Test sequence has been completed, and presented 

satisfying nozzles status - One may proceed with printing from the Host 

computer. 

 

6.1.6 Procedure for cleaning or replacing the Wiper 

Blade  

The wiper blade installed in the Eden330/333 requires an easy cleaning by 

the user, as part of the routine maintenance procedure. This wiper blade 

can be also easily replaced if required. 

For cleaning or replacing the wiper blade, click the Options pull-down-

menu, and select the Clean Wiper option. 

The system will raise the wiper blade and prompt the user to replace or 

clean the wiper blade. 

 



www.goengineer.com

3D PRINTER SALES
info@goengineer.com
800.688.3234

3D PRINTER SUPPORT
AMsupport@goengineer.com
855.470.0647

CONSUMABLES HELP
supplies@goengineer.com
855.470.0647

Objet Geometries Ltd                                      Eden330/333 User Manual 

                                                                                                                        3  - 6 

 

 

                                     Figure 5: Wiper Cleaning Screen 

                   

                                    Figure 6: Wiper Blade Removal 
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6.1.7 Loading and Replacing Material Cartridges   

The Objet Eden330/333 operates with one cartridge of Model material and 

one cartridge of Support material for printing models. The net weight of 

each cartridge is 2.0 kilograms (4.4 lbs.)  .  When facing the Eden330/333, 

the cartridges are located in two pullout drawers in the cabinet at the 

lower left front of the machine.  

The cartridges may be replaced either while the machine is operating or 

idle. If replacement takes place during operation, the process should be 

done as quickly as possible to ensure the continuous validity of the print 

process.  

Do not allow the replacement of a cartridge to exceed 30 seconds when the 

machine is operational. 

 

  To replace and load these cartridges: 

1.    Open the left cabinet door and pull open the cartridge drawer 

containing the cartridge to be replaced. 

2.    Take care to load Model material into the Model drawer and Support 

material into the Support drawer (resin containers are keyed in order 

to prevent misplacement). 

       Grasp the handle of the cartridge firmly and pull straight out.  Do not 

twist or turn the cartridge to remove. 

       When the MMS (PolyLog material management System) determine 

that the cartridge is empty – it will prompt a message on screen. The 

Objet Studio program in the Host computer will also generate on 

screen message 100 grams (or 15 minutes) before the cartridge is 

empty 

        Grasp a new cartridge (or the partially used cartridge) firmly by the 

cartridge handle, and pull it out. 

6.   Insert the new cartridge directly into the drawer.  Some resistance will 

be felt as the needle pierces the rubber stopper at the front of the 

bottle. 

7.    Press the cartridge securely into the drawer.   

        To check that the bottle is entirely in place with the needle well inside 

the stopper, press the cartridge firmly and refer to the Eden330/333 

application to see the detected existing resin quantity.  

        Close the left cabinet door. 
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                                  Figure 7: Open the left door   

                     

 
                                  Figure 8: Pulling cartridge out 
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6.1.8 Replacing the External Waste Container 

The waste container contains partially cured polymeric material generated during 

printing heads maintenance, and should be considered according to the safety 

requirements as described in the User Manual.  

The waste container has been designed for a long period of time, and might keep up 

to 3 months of non-stop working. The user is requested therefore to observe for a full 

container, and replace it accordingly, during the daily maintenance. Note that the 

application includes the current external weight container weight, and will alert the 

user once the weight reaches 7Kg (maximum external weight capacity is 8Kg). 

To replace and load the waste container, follow the next steps: 

1.   Gently, pull out the external waste container located at the machine 

lower cabinet. Treat it content as polymeric material. Be aware of the 

pipe entering the container. 

2.   Lift up the container or shake it in order to feel if the container is full.  

3.  You may empty out the external waste container even if it has not 

reached maximum level – Note to treat it content as polymeric 

material.  

4.   While done, insert a new container by driving it back underneath the 

cabinet, ensuring it is placed correctly onto the load cells. 

 

               
                               Figure 8: The Waste Container Display 
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6.1.9    Daily & Bi-Weekly Maintenance  

 

 

The Eden330/333 has been designed to provide trouble-free operation.  The system 

does however require minimal routine maintenance. 

Warning: Operation and maintenance of the Eden330/333 is to be carried out by 

trained personnel only. 

Cleaning Procedures  

       Perform the following cleaning procedures every day, at the end of the last shift.  

 

• Check if the external waste container is full and replace if required. 

• Check if the material bottles have enough for the next shift. Prepare 

additional resin bottles to be available if required. Please note - As the 

Eden330/333 is equipped with PolyLog system, there is no need to 

replace the bottles – unless required by the Job Manager.  

• Clean the top table of the system with a cloth soaked in water. If liquid 

material has spilled. (Model/Support) clean with a cloth soaked with 

Propanol. For any material leakage – Please contact immediately Objet 

technical support. 

Other Routine Procedures – Every other week 

• General Maintenance - While the machine is ON – perform the       

           following heads cleaning: 

- Verify that there is no model on the tray. 

- Select the ‘Move to Head Maintenance Position’ command from 

Eden330/333 main menu. 

- Place a mirror onto the tray and carefully clean the heads with a cloth 

soaked with Propanol. Note to clean well the orifice plate, in between 

heads, and underneath the roller bath.  

- Using the mirror, inspect also for any cured dirt, and remove it gently 

by scratching it out using a fingernail. Do not use sharp tools, such as 

knife blade etc. Note that the heads may be hot, and required 

precaution. 
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- Clean the wiper blade with a cloth soaked with Propanol. Replace if 

needed 

  

• Wiper Blade Cleaning -Clean the wiper blade with a cloth soaked with 

Propanol. Replace if needed. 

• Pattern Test - Perform a Pattern Test and review the nozzles status with 

respect to the last printed result. In the case of missing nozzles, clean the 

heads with a cloth soaked with Propanol and perform additional manual 

purges. 

• Computer Reset  - Perform a computer reset for the Embedded computer 

once a week. 
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6.1.10 UPS and emergency power recommendations 
 

Introduction: 
 

A wide variety of natural electrical system failures can cause short-term 

power outages. A power outage of very short time can cause problems to 

computer systems (most often causes your PC to boot and lose some data) or 

operating machines, such as the Eden system. An Uninterruptible Power 

Supply is a device that sits between a power supply (e.g. a wall outlet) and a 

device (e.g. a Host computer or Eden machine) to prevent undesired features 

of the power source (outages, sags, surges, etc.) from adversely affecting the 

performance of the machine. The UPS industry is made up of many 

manufacturers, and there is a lack of standard terms or specific UPS 

recommendation. There are basically three different types of devices, all of 

which are occasionally presented as UPSs:  

o Standby power supply (SPS): In this type of supply, power is usually 

derived directly from the power line, until power fails. After power 

failure, a battery-powered inverter turns on to continue supplying 

power. Batteries are charged, as necessary, when line power is 

available. This type of supply is sometimes called an "offline" UPS.  

o Hybrid or Ferro resonant UPS systems: When normal operating line 

power is present, the supply conditions power using a transformer. 

This transformer maintains a constant output voltage even with a 

varying input voltage and provides good protection against line 

noise. The transformer also maintains output on its secondary briefly 

when a total outage occurs. When main power is lost, power inverter 

then goes on.  

o "True" UPS systems: This type of system continuously operates from 

an inverter. In this kind of system there is no switchover time, and 

these supplies generally provide the best isolation from power line 

problems. This UPS type is the one recommended for Eden 

machines. 
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In order to choose the right emergency power source and to size it properly, 

one should note for the power requirements of the Eden machine operated.  

One warning for UPS users: Keep in mind that devices are not designed to let 

you keep working for a long period of time; they are intended to give you 

with at least 10 minutes to shut your system down in the normal manner.  

 

 

 

Specifications: 

 

Please note that the power requirements for Eden machines are as described 

hereafter. While selecting a UPS unit, please refer to the relevant Eden 

machine below: 

Eden 330/333: 100-120V~ 50-60Hz 13.5A 1.6KW 

Eden 330/333: 220-240V~ 50-60Hz 8.0A 1.6KW 

 

Please note that Eden330/333 is operated over a wide range (100V- 240V~). 

The information provided above is for UPS selection only, subject to power 

rating at each country. 

 

The above are machine power consumption. UPS selection should be set 

accordingly (usually 20% higher rate). 
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Automatic and Controlled Machine Shutdown 
 

While selecting a UPS device, please note that you MUST choose a solution  

having a USB alert output for Graceful System Shutdown. For clarifying 

specifications, do not select a UPS device with Serial Com (RS-232 Protocol) 

signal output. 

 

Important Note: A UPS device, featured by a USB alert output for Graceful 

System Shutdown can be also used for Host computer backup. 

 

Once a UPS was installed on-site, one can set options for its operation using 

Power Options in Control Panel (Windows 2000 and Windows XP). The UPS 

settings available depend on the specific UPS hardware installed on-site. The 

settings may include options such as: 

• The serial port where the UPS device is connected (This option should be by 

USB).  

• The conditions that trigger the UPS device to send a signal, such as a utility 

power failure, low battery power, and remote shutdown by the UPS device.  

• The time intervals for maintaining battery power, recharging the battery, and 

sending warning messages after power failure.  

For activating the USB alert output for Graceful System Shutdown, use the 

Eden C:\Eden330\ServiceTools\UPS_Support\ (available on Eden Version 3.2 

and up). 

 

Technical Notes: (1) Before changing these settings, see the documentation 

that came with your UPS. (2) You must be logged on as an administrator or a 

member of the Administrators group in order to complete the UPS settings. If 

your computer is connected to a network, network policy settings may also 

prevent you from completing this procedure.  
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6.3 Procedure for Single Head Replacement 
 

1.3.1 General 

 

1. The objective of this procedure is to guide users through the Single Head 

Replacement procedure. 

2. Follow the safety instructions before performing the Single Head 

Replacement 

 

1.3.2 Why and when to replace a single head? 

 
1. Single Head Replacement should be carried out in any one of the 

following cases: 

1.1 A large number of nozzles or all nozzles on a single head are not 

functioning or “missing”. Only heads missing more than 15 nozzles 

should be considered for replacement 

1.2 Printing head is damaged (orifice plate is peeling or has bubbles).  * 

1.3 Printing head is jetting a very low weight. ** 

  

2. The following are general guidelines as to when to avoid head 

replacement. 

2.1 Do not remove single heads if the printing block is full of resin. The 

printing block must be empty before head replacement. 

2.2 Do not remove or attempt to replace heads during printing, as head 

replacement requires performance of ‘Weight Test’. 

 
*   Note: Head replacement in this case should be done only if the damaged orifice plate     

               affects missing nozzles or printing quality. 

** For optimizing a single head’s weight, or adjusting other heads to same level as the   

    defective head,  please refer to ‘Optimizing Heads’ procedure. 

 

17.1  Required Tools 
 

1. Gloves (pair). 

2. Flat-end screwdriver (5mm). 

3. FlipScale or other weight measurement tool (with minimum accuracy of 0.05 gr). 

4. Wiping cloth and Propanol spray. 
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17.2  Step-by-step Procedure for Single Head Replacement 

 

       Review: 

 

1. Single Head Replacement (SHR) is based on 4 major steps, as follows: 

1.1 Identify the head to be replaced: This should be done primarily by 

performing a Pattern Test which will determine if any of the heads 

needs to be replaced, according to the number and location of 

missing nozzles on this head. Please note that missing nozzles spread 

out over the head may draw a different conclusion, as opposed to all 

missing nozzles being in one area. In addition, missing nozzles may 

still be revived if head wiping is not adequate or wiper blade is 

defective. Always perform purges, manual head cleaning and wiping 

before determining final status of missing nozzles. 

1.2 Preparing the printing block for head replacement: This step is 

done automatically by the Eden application during the Wizard 

process.  The application will empty the heads, and prompt the user 

to replace required head. 

1.3 Replace malfunctioning heads: Remove malfunctioning head, tag it 

and record relevant information with regards to this head [(1) Total 

printing time (2) Head location in block (3) Head S.N. (4) Block S.N. 

(5) known weight (6) malfunction description]. Insert new head. 

1.4 Automated Calibration: The wizard will perform an automatic  

‘Weight Test’. The user will be required to measure the weight of 

printed cube for replaced head, and enter the result into the wizard 

screen. 
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Figure 9: Illustration of 4-steps for SHR 

 

2. Step 1: Identify the head to be replaced:  

2.1 This should be done primarily by performing a Test Pattern, which 

will determine if head needs to be replaced, according to number and 

location of missing nozzles on this head. Please note that missing 

nozzles spread out over the head may draw a different conclusion, as 

opposed to all missing nozzles being in one area 

 



www.goengineer.com

3D PRINTER SALES
info@goengineer.com
800.688.3234

3D PRINTER SUPPORT
AMsupport@goengineer.com
855.470.0647

CONSUMABLES HELP
supplies@goengineer.com
855.470.0647

Objet Geometries Ltd                                      Eden330/333 User Manual 

                                                                                                                        3  - 18 

                   
 

 

                                            
Figure 10: Performing ‘Test Pattern’ 
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Figure 11: Example of peeling orifice plate.  

 
* Note that when an orifice plate peels at either end this might not necessarily affect nozzles   

   status, and therefore Single Head Replacement should be reconsidered. 
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Figure 12: Example of a severe case of missing nozzles 
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3. Starting the Head Replacement:  

3.1 This step will be carried out automatically and will take few minutes. 

The Wizard will empty the heads before Single Head Replacement 

wipe the heads when done. 

3.2 Please note that head replacement does not require washing the 

heads with washing detergent. Nevertheless, as uncured resin would 

be exposed in the material entry holes located in the block, please 

perform the single head replacement as quickly as possible, after 

removing the head. 

                            

 
Screen 13: Welcome to Head Replacement Wizard 

 
Click ‘Next’ to start the Head Replacement Wizard, or ‘Cancel’ to abort. 
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Screen 14: Select the head(s) to be replaced 

 
Select the head you are about to replace. You may have multiple 

selections of a few heads at the same time. 

Please note the head order, as shown in the picture (Head S3 is first left; 

Head M0 is far right). 

When done: 

Click ‘Next’ to continue the Head Replacement Wizard, or ‘Cancel’ to 

abort. 
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Screen 15: Emptying block process 

 
At this stage, the printing block would automatically be positioned over 

the wiper location, and the head will drain. 

Please note that this step may take few minutes, as it requires heating of 

the heads prior to the draining process. 

When done: 

Click ‘Next’ to continue the Head Replacement Wizard, or ‘Cancel’ to 

abort. 
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4. Head Replacement:  

4.1 This step will be guide the user through actual head replacement, 

after the head’s draining has been completed. 

                            

 
Screen 16: Replacing the head 

 

At this stage, the user is prompted to replace the head(s) selected. 

 

For information of how to remove an insert a new head, follow the next 

steps.  

When done: 

Click ‘Next’ to continue the Head Replacement Wizard, or ‘Cancel’ to 

abort. 

 
5. Replacing a Head – Removing Malfunctioned Head: 

5.1 Please note that prior the head replacement; the wizard will turn OFF 

part of the machine ‘Power’. 

5.2 Follow the next steps, as described below: 
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Figure 17: Open the new SHR box, and carefully read the enclosed safety   

                    instructions 

 

            Figure 18: Wear the safety gloves prior to the SHR procedure 
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                 Figure 19: Release lower locking screw (Head S2 in this example)* 

               

                  Figure 20: Release Upper locking screw (Head S2 in this example) 
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Figure 21: Use a Flat-End screwdriver if necessary 

                 

Figure 22: Open the ‘Heads Driver’ compartment by releasing the door screws 
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Figure 23: Lift the ‘Heads Driver’ compartment door to vertical position 

 

               

Figure 24: Press the lower head’s screw 
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Figure 25: Press the upper head’s screw 

               

                   Figure 26: Pull out the head’s driver card (about 5mm) until it is released 

from its connector 
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Figure 27: The head would already be almost falling out. 

 Hold your hand underneath it and gently 

 withdraw it from the printing block 

 Figure 28: Pull the entire head out. Make sure the head card 

 is slides  easily down and out. 
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6. Step 4: Replacing a Head – Installing New Head: 

6.1 Remove the new head from its packing, and record the head S.N. 

 

                      

Figure 29: Gently, remove the head from its packing. 

                  

          Figure 30:       Insert the new head into position. Note the ‘Front’ and ‘Back’   

                                   markings on head driver’s cover (connector on head driver  

                                   should be on the back of the head). 

                                  Also, ensure that the rubber O-ring exists at both ends of the head,  

                                  as shown above. 
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Please also note if the O-ring is missing from the removed head. In this case, the O-

ring may still be in the head’s entry holes and must be removed prior to head 

replacement 

 

 

Figure 31: Insert the head driver into its slot by pressing it gently as shown above. 
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Figure 32: Lock and tighten the lower and upper screws by hand 

 

Figure 33: Lock and tighten the head driver compartment as shown above and 

remove all tools from tray. 
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Screen 34: Confirm the head replacement 

7. After Head Replacement - Confirm:

This stage guides the user after head replacement, in order to ensure that

the new head was inserted correctly.

Screen 35: Ensure the replaced head is level with all other heads. 

This should be done by passing your fingers under the heads to confirm that 

all are at the same level. 



www.goengineer.com

3D PRINTER SALES
info@goengineer.com
800.688.3234

3D PRINTER SUPPORT
AMsupport@goengineer.com
855.470.0647

CONSUMABLES HELP
supplies@goengineer.com
855.470.0647

Objet Geometries Ltd                                      Eden330/333 User Manual 

                                                                                                                        3  - 35 

 

 

Screen 36: Confirm that all tools and damaged heads have   

                    been removed from the tray and machine   

                    working area. 

 

Screen 37: If the newly inserted head is not recognized by the software,   

                    the user will be requested to reinsert the head’s driver card. 
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 Screen 38: If the head does not contain the factory data, 

 the user will be requested to insert a new version of the 

 head. 

Screen 39: At this stage, the system will perform an automated vacuum 

 test to ensure there is no vacuum leakage as a result of head 

 replacement. 
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Screen 40: An automated test has detected that the vacuum 

is dropping due to incorrect head installation. The wizard 

will guide the user how to remove and reinsert the head. 

This may take some time, as the system will empty the heads 

once again. 

 

 

 
 

Screen 41:      At this stage, the system will perform an automated purge. 

This may take few minutes, as the system needs to heat and fill the heads. 
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8. After Head Replacement – Automated Weight Test:  

When head replacement has been completed, the application will 

perform an automated weight test in order to detect and set the head’s 

weight properties.   

 

What is a ‘Weight Test’? A weight test is an automated test mode, 

whereby the system prints a set of 8 rectangles (one from every head), 

lasting about 25 minutes. Examination of these rectangles (from each 

head) will assist in determining the heads’ exact jetting properties. 

Once weight test printing has been completed – the user will be required 

to weigh the rectangle printed by the newly replaced head and enter its 

weight measurement into the Wizard. 

 

 
Screen 42: The automated weight test printing will last about 25 minutes. 

 



www.goengineer.com

3D PRINTER SALES
info@goengineer.com
800.688.3234

3D PRINTER SUPPORT
AMsupport@goengineer.com
855.470.0647

CONSUMABLES HELP
supplies@goengineer.com
855.470.0647

Objet Geometries Ltd                                      Eden330/333 User Manual 

                                                                                                                        3  - 39 

 
Screen 43: Printing the weight test 

 

 
 

When weight test printing has been completed, the user will find a 

number of rectangles on the tray, as detailed below.  

Please pay special attention to the order of the rectangles (S3 being the 

furthest left; M0 being the furthest right). 

You may use an ink marker on the tray to mark the order of the 

rectangles, as shown below. 
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Figure 44: The ‘Weight Test’ Order 

 

 

                         
 

Figure 45: Removing the ‘Weight Test’ rectangles 
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Figure 46: Measuring the weight of each rectangle 

 

 

Important Note: Measure rectangles of all heads, including the replaced 

head(s) and insert results into the wizard screen.  

Tip:  Required Model weight should be approximately 3.65 grams (per 

rectangle);  Required Support weight should be approximately 3.55 

grams (per rectangle). 
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Screen 47: Entering the weight test data 

Screen 48: SHR has been successfully completed 


